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1 Introduzione 
 
AVAL-1D è il programma di dinamica delle valanghe sviluppato dall'Istituto Federale per 
lo Studio della Neve e delle Valanghe SNV di Davos in grado di calcolare distanze di 
arresto, velocità e pressioni per valanghe dense e polverose.  
 
Grazie ad esso, gli utilizzatori del programma sono in grado di compilare carte delle aree 
soggette al pericolo di valanghe. Negli ultimi anni presso l'Istituto SNV sono stati 
sviluppati due nuovi modelli di calcolo per la simulazione di valanghe polverose, e per la 
simulazione   valanghe dense. Questi modelli permettono di valutare dettagliatamente i 
pericoli indotti da valanghe dense e polverose ed eliminano alcuni noti problemi del 
modello Voellmy-Salm. Per facilitarne l'impiego pratico è stata realizzata un'interfaccia 
grafica comune. Questa interfaccia è stata studiata in modo tale da permettere anche a 
persone con poche conoscenze nel settore informatico un facile apprendimento e utilizzo. 
L'interfaccia utente è stata programmata in linguaggio IDL (Interactive Data Language). 
 
AVAL-1D include due moduli di calcolo indipendenti l'uno dall'altro: FL-1D per valanghe 
dense e SL-1D per valanghe polverose, entrambi programmati in C. Entrambi i moduli 
risolvono con il metodo alle differenze finite le equazioni di conservazione della massa, 
dell'energia e della quantità di moto.  
 
© 1999 - 2001 SNV Davos 
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2 Procedura di calcolo di una valanga radente 
 

Contrariamente al modello analitico Voellmy-Salm, che predice velocità massime e 
altezze di flusso in pochi punti selezionati lungo il percorso, nel modello numerico FL-1D i 
calcoli vengono effettuati lungo l'intera topografia. Per ogni elemento del profilo è 
necessario specificare i parametri di attrito. Nei modelli numerici, i valori di attrito 
possono essere variati lungo tutto il profilo valanghivo in accordo con la topografia del 
percorso. Ciò offre il vantaggio di poter considerare in modo più dettagliato le variazioni 
topografiche lungo tutta la zona di scorrimento della valanga. Lo svantaggio è invece 
rappresentato dal fatto che i parametri possono anche essere scelti arbitrariamente e in 
differenti combinazioni, per cui differenti utenti potrebbero trovare soluzioni diverse per 
lo stesso problema. Per evitare la scelta indiscriminata dei parametri, è stata preparata 
una lista di valori indicativi, raccomandati dall'Istituto SNV, per i calcoli con il modello FL-
1D. Deve essere tenuto in considerazione che i valori contenuti nella lista sono indicativi  
e che il modello FL-1D deve ancora essere calibrato sulla base degli eventi catastrofici del 
1999. Se utilizzando i parametri raccomandati dovessero risultare enormi discrepanze tra 
le simulazioni fornite dal modello e gli eventi valanghivi osservati in realtà, è necessario 
informare l'Istituto SNV.  

Di seguito vengono elencate le fasi più importanti per il calcolo di una valanga radente 
con AVAL-1D: 

o determinazione dello spessore del distacco 

o valori indicativi dei parametri di attrito per il modello FL-1D 
o determinazione del profilo topografico 
o determinazione della larghezza della valanga 
o determinazione della lunghezza dell'area di distacco 
o immissione dei parametri in AVAL-1D 
o selezione dei parametri di calcolo 
o immissione di punti di controllo aggiuntivi (monitoring point) 

 

2.1 Determinazione dello spessore del distacco per valanghe 
dense 

 
Lo spessore medio del distacco per valanghe dense deve essere valutato in base alla 
procedura descritta nel Comunicato n° 47 dell'Istituto SNV "Calcolo di valanghe dense: 
una guida per l'esperto con esempi". 

La zona di distacco è generalmente definita da pendenze comprese fra 30° 
(eventualmente 28°) e 50°. Lo spessore medio della frattura d0, misurato  
perpendicolarmente al pendio, si determina con la formula: 

d0 = d0* · ƒ(ψ)  

dove: 

• d0* rappresenta la massima altezza di neve caduta in 3 giorni successivi, 
(calcolata come differenza dell'altezza della neve al suolo). Questo valore dipende 
dal periodo di ritorno T. La normativa svizzera fornisce valori indicativi relativi ad 
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un'altitudine di 2000 m.s.l.. Per differenti altitudini il fattore di correzione è pari a 
5 cm ogni 100m. In presenza di accumuli di neve soffiata in aree più o meno 
estese della zona di distacco, i valori d0* devono essere aumentati di 0.3-0.5 m 
circa. Il valore d0* determinante ai fini del calcolo è quello medio lungo tutta la 
zona di distacco.  

• ƒ(ψ) è chiamato fattore di pendenza. E' utilizzato per correggere lo spessore del 
distacco in funzione della pendenza del pendio (a parità  di d0*, maggiore e' la 
pendenza minore e' lo spessore del distacco) . 

 

 
Tabella 1: Fattore di pendenza ƒ(ψ) 

 

 

2.2 Determinazione dei parametri di attrito per valanghe dense 
 
Valori indicativi per il modello FL-1D 

In generale si può affermare che, rispetto ai parametri del modello analitico Voellmy-
Salm, il valore di µ e' solo leggermente differente, mentre il coefficiente di attrito 
turbolento ξ deve essere aumentato fino a 2.5 volte. Uno dei motivi che hanno portato a 
questo incremento del valore di ξ è rappresentato dal fatto che la topografia non viene 
più semplificata (mediata), ma costantemente adeguata al terreno su distanze di 80-200 
m. L'adeguamento del percorso della valanga a caratteristiche più reali causa una 
maggiore perdita di energia, che deve essere parzialmente compensata da un coefficiente 
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ξ superiore (ovvero da una minore resistenza di attrito). L'altra ragione che ha indotto ad 
elevare i valori di ξ  è da attribuirsi alle altezze di flusso che risultano minori di quelle 
calcolate con il modello di Voellmy-Salm. Dal momento che il coefficiente ξ e l'altezza di 
flusso sono direttamente proporzionali, per compensare la minore altezza di flusso deve 
essere utilizzato un valore maggiore per ξ. L'aumento del valore di ξ è causa di un netto 
aumento delle velocità lungo la zona di scorrimento  e all'inizio del tratto di arresto. Le 
misurazioni di velocità effettuate in prossimità del Passo del Lucomagno nell'anno 1984 e 
presso il sito sperimentale Vallée de la Sionne nel 1999 dimostrano che queste maggiori 
velocità sono più realistiche rispetto a quelle del modello analitico Voellmy-Salm. 
L'aumento del valore di ξ non ha effetti rilevanti sulla distanza di arresto della valanga. 
Le valutazioni eseguite sino ad oggi dimostrano che, in seguito a una maggiore variabilità 
delle caratteristiche morfologiche della zona di arresto, la valanga viene rallentata con 
maggiore intensità e si arresta all'incirca nello stesso punto del modello Voellmy-Salm.  
 
Nel modello analitico Voellmy-Salm veniva assunta una riduzione lineare della velocità tra 
il punto P e il punto terminale di arresto. Sulla base di questa assunzione veniva 
determinata la lunghezza della zona blu. Il modello numerico non conferma questa 
riduzione lineare, ma tipicamente, mostra un forte rallentamento all’inizio del tratto di 
arresto. Le velocità generalmente più elevate del modello FL-1D fanno sì che il limite tra 
zona rossa e zona blu non sia molto differente da quella determinata dal metodo di 
calcolo tradizionale.  

I parametri di attrito ξ e µ variano sulla base delle seguenti caratteristiche (vedere 
tabella 2):  

• volume della valanga: 3 categorie  

• altitudine dell'elemento del profilo: 3 categorie  

• canalizzazione e rugosità della topografia: 3 categorie  

• tempo di ritorno: 2 categorie  

• umidità: 2 categorie 

Variazione sulla base del volume della valanga 

La cubatura della valanga era già stata considerata per la definizione dei parametri di 
taratura nel modello analitico di Voellmy-Salm, dove tuttavia veniva considerata una 
distinzione solo tra valanghe di grandi dimensioni (> 100.000 m3) e valanghe di piccole 
dimensioni(< 10.000 m3). Dimensioni intermedie dovevano essere valutate di volta in 
volta direttamente dall'utilizzatore.Con il modello FL-1D si tenta ora di colmare questa 
lacuna. I limiti di 25.000 m3 e 60.000 m3 non sono tuttavia perentori e possono essere 
adeguati. Contrariamente al modello analitico Voellmy-Salm, anche il parametro ξ varia 
in funzione della cubatura. Il motivo è dovuto al fatto che è stato accertato che la 
velocità di grandi valanghe è notevolmente superiore a quella di piccole valanghe. Queste 
differenze di velocità non possono essere ottenute solo con una variazione del valore µ.  

Variazione sulla base dell'altitudine della valanga  

Anche l'altitudine della valanga era già stata considerata per la definizione dei parametri 
di taratura nel modello analitico di Voellmy-Salm. Nel modello numerico questa 
dipendenza viene perfezionata con l'aggiunta della una nuova categoria "Sotto i 1000 m 
s.l.m.". Per ogni elemento del profilo della valanga, i parametri dovrebbero essere 
adeguati all'altitudine di questo elemento. Anche in questo caso i limiti imposti (1000 m e 
1500 m s.l.m.) non sono perentori e possono essere adeguati dall'esperto. Il motivo della 
variazione dei parametri in base all'altitudine si basa sull'assunzione che a quote più 
elevate la neve è più asciutta rispetto alle quote più basse e che quindi, a quote piu 
elevate, l'attrito è inferiore.  
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Variazione sulla base della canalizzazione e della rugosità della topografia 

Esattamente come nel modello analitico, anche in quello numerico l'attrito varia in 
funzione della canalizzazione e della rugosità. Nella versione attualmente disponibile non 
esiste purtroppo alcuna possibilità di specificare sezioni  che non abbiano forma 
rettangolare. Per poter riprodurre il più fedelmente possibile la rugosità e la 
canalizzazione lungo la traiettoria della valanga, sono state create le categorie illustrate 
nella tabella che segue.  

Categoria Definizione 
di versante curvatura isoipsa > 90° 
canalizzata curvatura isoipsa < 90° & larghezza/altezza del flusso > 3/1 
fortemente 
canalizzata 

curvatura isoipsa < 60° & larghezza/altezza del flusso < 3/1, 
rugosità molto elevata (ordine di grandezza (m)) 

La variazione dei parametri di attrito sulla base della canalizzazione presenta ancora 
alcune incertezze. Di conseguenza è opportuno effettuare dei test di sensibilità 
(variazione dei parametri). È importante che anche in questo caso vengano prese in 
considerazione esclusivamente canalizzazioni di una certa rilevanza, che si sviluppano per 
una distanza di oltre 80 m.. 

Variazione sulla base del tempo di ritorno  

Contrariamente al modello analitico Voellmy-Salm, i parametri di attrito variano anche in 
base al tempo di ritorno. Il concetto alla base di questa scelta è che con una periodicità di 
30 anni è possibile presupporre non solo una minore profondità della frattura, ma anche 
condizioni nevose meno estreme. Di conseguenza i valori di µ che rispecchiano le 
condizioni nevose sono stati generalmente aumentati di 0.01 ed è stata apportata anche 
una leggera modifica ai valori di ξ.  

Variazione sulla base dell'umidità  

Soprattutto a quote più basse si osservano spesso valanghe di neve bagnata. Come nel 
modello analitico Voellmy-Salm, anche in quello numerico FL-1D vengono specificati 
parametri per riprodurre simili valanghe. È stato dimostrato che nelle valanghe di neve 
bagnata la cubatura gioca solo un ruolo marginale. Occorre tuttavia sottolineare che 
anche a quote basse è necessario includere le valanghe asciutte per il calcolo delle zone 
di pericolo blu e rosse. 

Il fattore dell'attrito turbolento ξ 
• ξ dipende soprattutto dalla geometria della traiettoria (rugosità, canalizzazione, 

vegetazione). 
• Soprattutto in presenza di grandi valanghe, le rugosità medie possono essere 

spianate dalla neve; in caso di dubbio utilizzare quindi il valore massimo di ξ! 
• Una singola valanga può presentare valori di ξ differenti (p.es. zona di distacco 

pianeggiante e traiettoria fortemente canalizzata). 

 7  



Corso di dinamica delle valanghe, Bormio, Italia   SLF Davos   
dal 4 al 5 Dicembre 2002  AINEVA 
_________________________________________________________________________________________ 

Il coefficiente di attrito µ 

• µ dipende soprattutto dalle caratteristiche della neve (temperatura, densità, 
contenuto in acqua) ma anche dalla pressione esercitata dalla valanga 
perpendicolarmente alla superficie del terreno e dalla velocità (diminuisce 
all'aumentare della velocità). 

• Le altitudini sul livello del mare si riferiscono alla zona di deposito. 
All'interno dello stesso percorso valanghivo e a parità di tutte le altre condizioni,  µ può 
essere pari a 0.155 per grandi valanghe e pari a 0.30 per piccole valanghe. 
 

2.3 Parametri di attrito ξ e µ per valanghe dense 
 
La seguente tabella contiene i valori provvisori dei parametri di attrito µ e ξ per il modello 
FL-1D. I parametri di attrito variano in funzione delle dimensioni della valanga, 
dell'altitudine, della canalizzazione del terreno e del tempo di ritorno. Attenzione: questi 
valori non sono ancora stati verificati sulla base delle valanghe catastrofiche del 1999! 
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Grande valanga ( > 60.000 m3 ) 300 anni  30 anni 
  Altitudine (s.l.m.)  µ ξ µ ξ 
            

oltre 1500  0.16 2500 0.17 2000 
1000 – 1500  0.18 2000 0.19 1750 di versante 
sotto 1000  0.20 1750 0.21 1500 

            
oltre 1500  0.20 1750 0.21 1500 
1000 – 1500  0.25 1500 0.26 1500 Canalizzata 
sotto 1000  0.30 1200 0.31 1200 

            
oltre 1500  0.30 1000 0.31 800 
1000 – 1500  0.34 750 0.35 600 fortemente canalizzata 
sotto 1000  0.38 500 0.39 400 

            
Valanga medio-grande ( 25.000 – 60.000 m3 )         

oltre 1500  0.20 2000 0.21 1750 
1000 – 1500  0.24 1500 0.25 1500 di versante 
sotto 1000  0.28 1200 0.29 1200 

            
oltre 1500  0.26 1200 0.27 1200 
1000 – 1500  0.29 1200 0.31 1200 Canalizzata 
sotto 1000  0.33 1000 0.34 1000 

            
oltre 1500  0.33 1000 0.34 800 
1000 – 1500  0.37 800 0.38 600 fortemente canalizzata 
sotto 1000  0.40 500 0.41 400 

            
Piccola valanga & valanga di neve bagnata 
( < 25.000 m3 )         

oltre 1500  0.30 1500 0.31 1200 
1000 – 1500  0.32 1200 0.33 1200 di versante 
sotto 1000  0.34 1200 0.35 1000 

            
oltre 1500  0.32 1200 0.33 1000 
1000 – 1500  0.34 1000 0.35 800 Canalizzata 
sotto 1000  0.36 800 0.37 600 

            
oltre 1500  0.36 800 0.37 600 
1000 – 1500  0.40 500 0.41 400 fortemente canalizzata 
sotto 1000  0.42 500 0.43 400 

 
Tabella 2: Valori provvisori dei parametri di attrito µ e ξ per il modello FL-1D. 
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2.4 Fasi importanti 

Determinazione del profilo del terreno  

Contrariamente al modello Voellmy-Salm, il modello FL-1D riproduce la topografia più 
conformemente alla realtà. Da un punto di vista teorico sarebbe addirittura possibile 
riprodurre la topografia con qualsiasi risoluzione. Durante la stagione invernale la 
topografia è però spesso alterata dagli strati di neve presenti. Una riproduzione ad alta 
definizione di un terreno privo di neve non rispecchia quindi fedelmente le condizioni 
reali. Di conseguenza, anche nel modello numerico occorre considerare determinate 
semplificazioni del terreno.  
 
Per la determinazione della topografia nel modello FL-1D devono essere seguite le 
seguenti regole: 

1. la distanza reale tra due punti del profilo deve essere compresa fra 80 e 220 m.  
2. A condizione che venga rispettata la regola 1, nella zona di deposito la differenza 

di altitudine tra 2 punti del profilo non deve essere inferiore a 20 m (ciò significa 
punti con differenze di soli 10 m solo con pendenze inferiori a 5°!)  

3. In presenza di un brusco passaggio tra la zona di scorrimento e una zona di 
deposito orizzontale (0°), le distanze tra i punti potranno essere anche minori in 
modo da poter riprodurre più accuratamente le caratteristiche reali della 
topografia nel punto di passaggio.  

4. Nell'ambito delle tre regole specificate sopra, occorre riprodurre le caratteristiche 
topografiche con la massima fedeltà possibile.  

Grazie a queste regole si ottiene un delicato livellamento della topografia. Questo 
livellamento non è necessario solo perché durante la stagione invernale il terreno è 
effettivamente spianato dalla neve, ma anche perché piccole irregolarità topografiche non 
esercitano alcun influsso sulla valanga, soprattutto se di grande entità. Per contro, il 
modello FL-1D reagisce con estrema sensibilità a variazioni dell'inclinazione del pendio su 
minime distanze. Frequenti cambi di inclinazione inducono il modello a rallentare la 
valanga molto più rapidamente rispetto ad un tratto di lunghezza identica ma con una 
pendenza pari alla media di tutti i valori precedenti. Ecco perché è necessario rispettare 
una distanza minima tra i vari punti del profilo topografico.  
 
Per riprodurre con la massima precisione possibile una valanga osservata, il programma 
permette di contrassegnare la distanza di arresto nota (endmark). Questa demarcazione 
può essere impostata solo in coincidenza di uno dei punti del profilo. Se la distanza di 
arresto di una valanga osservata non si trova in prossimità di un punto del profilo, con la 
funzione di interpolazione è possibile aggiungere un nuovo punto in questa posizione. Se 
viene aggiunto un punto con la funzione di interpolazione non è più necessario rispettare 
la regola della distanza minima compresa fra 80 e 220 m (misurata diagonalmente), 
perché la pendenza non cambia. Nella visualizzazione dei risultati della simulazione, nel 
punto predefinito compare un contrassegno a forma di freccia che permette di 
confrontare i risultati della simulazione con la distanza di arresto nota.  

 

Determinazione della larghezza della valanga  

La larghezza della valanga deve essere valutata sulla base dei dati catastali disponibili e 
di sopralluoghi effettuati sul terreno. In particolare, la larghezza della valanga lungo tutta 
la zona di arresto non dovrebbe essere superiore a quella indicata all'inizio della zona di 
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arresto neanche se le valanghe osservati si  espandono lateralmente. Questo 
presupposto "conservativo" serve a garantire un margine di sicurezza. Anche per 
l'applicazione del modello Voellmy-Salm viene utilizzato lo stesso artificio dove la 
larghezza BP della valanga nel punto P condiziona la distanza di arresto .  

Determinazione della lunghezza dell'area di distacco 

Rispetto al modello analitico di Voellmy-Salm, esiste una netta differenza per quanto 
riguarda la determinazione della lunghezza dell'area distacco. Nel modello numerico 
occorre infatti rispettare la seguente regola: 

Nel modello FL-1D la somma delle lunghezze orizzontali delle zone di distacco 
specificate non deve essere superiore a 500 m! 

Il motivo di tale limitazione è dovuto al fatto che nel modello FL-1D la massa della 
valanga rappresenta la base sulla quale vengono effettuati  i calcoli, mentre il modello 
Voellmy-Salm si basa sulla portata della valanga. Nel modello analitico una zona di 
distacco molto lunga non si traduce in un aumento della portata, mentre nel modello FL-
1D una lunga zona di distacco significa una massa maggiore e quindi velocità più alte e 
distanze di arresto più lunghe. Ciò può provocare notevoli differenze nei risultati. Il 
modello FL-1D non è in grado di considerare cambiamenti di massa lungo la traiettoria. 
In presenza di zone molto lunghe con pendenze comprese tra 30° e 50° è quindi 
necessario domandarsi dove finisce la zona di distacco (per così dire il "distacco iniziale") 
e dove inizia la traiettoria. Diverse valutazioni dei modelli hanno dimostrato che la 
lunghezza della zona di distacco deve essere limitata a circa 500 m per evitare una 
sopravvalutazione delle distanze di arresto. Occorre inoltre tenere presente che per 
l'immissione della lunghezza nel modello è necessaria la presenza di punti di profilo nel 
limite superiore e in quello inferiore della zona di distacco. Questi possono essere inseriti 
anche successivamente per mezzo della funzione di interpolazione. In questo caso non è 
più necessario rispettare la regola della distanza minima compresa fra 80 e 220 m 
(misurata diagonalmente), perché l'interpolazione non causa una variazione della 
pendenza. È anche possibile specificare più zone di distacco separate da zone 
pianeggianti. 

Immissione dei parametri in AVAL-1D 

Attraverso le fasi descritte precedentemente dovrebbero essere state determinate tutte 
le grandezze rilevanti per la valanga (i valori del coefficiente di attrito interno λ e della 
densità ρ non dovrebbero essere modificati). La relativa procedura è dettagliatamente 
descritta nel manuale di AVAL-1D, punto 3.4 a pag.33. In aggiunta alle grandezze 
rilevanti per la valanga, devono essere specificati anche i  parametri di taratura, 
necessari per controllare la simulazione, che possono influenzare sia la velocità che la 
distanza di arresto. Attraverso la modifica di queste grandezze è di norma possibile 
evitare anche eventuali instabilità numeriche. La selezione dei parametri più rilevanti è 
dettagliatamente descritta nel manuale di AVAL-1D, punto 4.1 a pag. 41.  

Immissione di punti di controllo aggiuntivi (monitoring point) 

Per una migliore documentazione dei risultati della simulazione si consiglia di immettere 
ulteriori punti di controllo lungo il profilo. Le velocità e le altezze di  flusso massime in 
prossimità di questi punti sono indicate nel file *.dlg. Inoltre vengono determinate le 
distanze tra questi punti e l'estremità della zona di pressione rosso-blu. L'immissione di 
questi punti non è tuttavia obbligatoria e non ha alcun influsso sul risultato della 
simulazione. L'immissione dei punti di controllo è descritta nel manuale di AVAL-1D, 
punto 2.3.8 a pag. 14.  
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2.5 Parametri di calcolo FL-1D 
 
Spiegazioni sui parametri di calcolo (Calculation Parameters... → Dense Flow) 

Attraverso questa funzione è possibile intervenire sui seguenti parametri di calcolo:  

• Rho & Lambda: questo menù serve per specificare la densità ρ, Rho (kg/m3) e 
l'attrito interno λ, Lambda ( ). Questi valori sono costanti per tutti gli elementi 
lungo la traiettoria della valanga. Di norma questi parametri non dovrebbero 
essere modificati, ma lasciati uguali ai valori di default specificati nella tabella 3 
sottostante.  

• Element Size & Time Step: attraverso questo menù è possibile impostare i 
parametri più importanti per controllare le funzioni numeriche della simulazione, 
ovvero la dimensione degli elementi di calcolo Element Size (m) e l'intervallo di 
tempo Time Step (s). Nella maggior parte dei casi questi due parametri numerici 
non devono essere variati, ma possono essere lasciati uguali ai valori di default 
specificati nella tabella 3 sottostante. 

• Max Time: un ulteriore parametro per il controllo del calcolo è il limite temporale 
Max Time (s). Trascorso questo periodo di tempo, il calcolo della valanga viene 
interrotto automaticamente. Di default il limite temporale è impostato su 300 s, 
un periodo di tempo sufficiente nella maggior parte dei casi. In presenza di 
valanghe con traiettorie particolarmente lunghe è tuttavia opportuno aumentare 
questo limite.  

• Dump Interval: l'ultimo parametro impostabile è l'intervallo di tempo con cui i 
risultati della simulazione verranno memorizzati per la visualizzazione (Dump 
Interval). Di norma l'intervallo di tempo è pari ad un secondo. In questo modo è 
possibile riconoscere immediatamente al momento della visualizzazione, il tempo 
di avanzamento della valanga. Infatti, sulla  barra scorrevole alla base della 
finestra principale, i time step indicati corrisponderanno esattamente ad un 
secondo di simulazione. Quanto più piccolo è questo intervallo, tanto più grande 
sarà l'entità dei dati memorizzati. In presenza di grandi valanghe il cui movimento 
dura sino a 300 s si consiglia di impostare un intervallo di 2 secondi. Questo 
parametro non ha alcun influsso sulla stabilità del calcolo numerico. 

 
 
Parametro Spiegazione Valore di default 
Name Nome della valanga < nessuno > 
Info Informazioni supplementari 

sulla simulazione 
< nessuno > 

Rho Densità (kg/m3) 300 
lambda Attrito interno ( ) 2.5 
Element Size Dimensione di un elemento 

di calcolo 
10 

Time Step Intervallo di tempo (s) 0.005 
Max Time 
 

Limite temporale di 
interruzione 

300 

Dump Interval Intervallo di tempo per la 
visualizzazione dei risultati 

1.0 
 

Tabella 3: Valori di default dei parametri di attrito costanti lungo tutta la traiettoria della valanga e dei 
parametri per il controllo di una valanga densa. 
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2.6 Il modello numerico per valanghe dense FL-1D 

Molti processi fisici possono essere descritti per mezzo di equazioni differenziali ed una 
equazione differenziale può fornire risultati differenti in base al metodo utilizzato per 
risolverla. Nel modello Voellmy-Salm, per esempio, l'equazione differenziale che descrive 
il moto della valanga è risolta analiticamente assumendo che la portata Q si mantenga 
costante lungo la traiettoria. I modelli analitici sono molto utili nell'impiego pratico, 
perché rappresentano in modo facilmente comprensibile e funzionale la dinamica del 
moto. 
 
Accanto alle soluzioni analitiche esistono vari metodi per risolvere numericamente le 
equazioni differenziali. Rispetto alle soluzioni analitiche, i metodi numerici offrono il 
vantaggio di poter risolvere spesso anche leggi più complesse all'interno di uno spazio 
bidimensionale o tridimensionale. Il principio di tutti i metodi numerici si basa sulla 
possibilità di risolvere approssimativamente un'equazione differenziale in passi molto 
piccoli ma finiti. 
 
Le equazioni differenziali utilizzate per la descrizione di questo modello continuo sono 
simili alle equazioni che governano il moto dei fluidi incomprimibili. In particolare, per 
descrivere il moto della valanga, sono utilizzate la legge di conservazione della massa e 
la legge di conservazione della quantità di moto. 
 
Le  ipotesi principali posso essere riassunte come segue:  

• la densità della neve è costante, ovvero il volume non cambia;  

• la larghezza della traiettoria w(s) è nota;  

• il profilo della valanga presenta una sezione rettangolare;  

• la velocità di deflusso u(s,t) è mediata sull'altezza di flusso h(s,t) (profilo di 
velocità costante);  

• l'altezza del flusso h(s,t) è mediata sulla larghezza w(s);  

• la massa rimane costante, ovvero la valanga non erode neve dal manto nevoso 
sul quale scorre.  

 

Figura 1: elementi fondamentali per la derivazione dell'equazione per la conservazione della massa 
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Le ipotesi alla base dell'equazione di conservazione della quantità di moto posso essere 
riassunte come segue:  

• la neve della valanga in movimento viene considerata come un fluido di densità 
media costante;  

• esiste una superficie della valanga ben definita che non è soggetta a particolari 
forze di attrito;  

• la velocità u(s,t) è una velocità mediata; il profilo di velocità è mediato sull'altezza 
h(s,t) ed ha forma rettangolare (profilo di velocità uniforme). Nella parte inferiore 
della valanga il profilo di velocità scende bruscamente a zero in un sottile strato 
limite;  

• la valanga esercita sul terreno una pressione idrostatica;  

• ogni elemento lungo la traiettoria della valanga è rappresentato da un segmento 
rettilineo. Le forze centripete che alterano la pressione idrostatica non vengono 
considerate;  

• il flusso della valanga  è instazionario e non uniforme  

la resistenza al movimento viene descritta dai tre parametri µ (attrito dinamico), ξ 
(attrito turbolento) e λ (attrito interno). 
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3 Procedura di calcolo di una valanga polverosa 
In questo capitolo vengono elencate e spiegate le singole fasi necessarie per il calcolo del 
pericolo valanghe in una zona minacciata da valanghe polverose. Per quanto possibile la 
procedura di calcolo per le valanghe polverose verrà spiegata di passo in passo come 
fatto per le valanghe dense. Le  differenze sostanziali tra le due procedure vengono 
elencate di seguito:  

1. solo una parte di tutte le valanghe dense di grosse dimensioni è accompagnata da 
una parte polverosa. Ciò deve essere tenuto in considerazione nel determinare il 
tempo di ritorno.  

2. Spesso le traiettorie percorse dalle valanghe polverose differiscono notevolmente 
da quelle delle valanghe dense.  

3. L'erosione e il deposito di masse di neve lungo il percorso della valanga giocano 
un ruolo centrale e devono essere considerati nel calcolo, almeno in forma 
approssimativa.  

4. Le valanghe polverose non presentano una distanza d'arresto chiaramente 
definibile.  

Le fasi più importanti della procedura sono indipendenti dal modello. Tra queste rientrano 
la determinazione dei volumi del distacco e la definizione della quantità di neve erodibile 
lungo la traiettoria in funzione del tempo di ritorno. Nei modelli bidimensionali e 
tridimensionali non è necessario specificare a priori la traiettoria della valanga, cosa che 
è invece necessaria per tutti i modelli monodimensionali. I modelli, in futuro, saranno in 
grado di calcolare la formazione della parte polverosa della valanga a partire dalla parte 
densa, semplificando in questo modo la determinazione delle condizioni iniziali.  

• Obiettivi e limiti dei calcoli 
• Determinazione dei parametri di distacco della valanga densa 
• Distanza di formazione e grado di sospensione di valanghe polverose 
• Determinazione dei parametri di erosione 
• Determinazione approssimativa della traiettoria di valanghe polverose 
• Selezione dei parametri di calcolo 
• Esecuzione dei calcoli con AVAL-1D 
• Valutazione dei risultati del calcolo 
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3.1 Obiettivi e limiti dei calcoli 

Esattamente come per il calcolo di valanghe dense, anche in questo caso vale quanto 
segue:  

Il calcolo numerico delle pressioni della valanga polverosa è solo uno strumento 
di supporto nella compilazione delle carte di pericolo! I risultati devono essere 
valutati in modo critico dall'utente.  

Metodi di calcolo monodimensionali sono soggetti alle seguenti limitazioni:  

1. la traiettoria della valanga polverosa deve essere stabilita a priori. 
2. Bruschi espansioni laterali o restringimenti della traiettoria possono essere 

calcolati esclusivamente con programmi bidimensionali o tridimensionali. 
3. I modelli monodimensionali mediano pressioni e velocità lungo l’altezza di flusso, 

Nella migliore delle ipotesi i profili di velocità e di pressione sono valutati sulla 
base di funzioni di calcolo introdotte a priori. 

Se uno dei punti menzionati sopra causa evidenti incertezze, occorre utilizzare un 
programma bidimensionale o tridimensionale, che di norma può essere impiegato solo da 
specialisti.  

 

3.2 Determinazione delle condizioni iniziali della valanga polverosa 

Le condizioni iniziali delle simulazioni numeriche vengono determinate in tre fasi: 

• selezione del tempo di ritorno; 

• determinazione dell'area di distacco, dello spessore del distacco e della massa del 
distacco per la valanga densa; 

• distanza di formazione e grado di sospensione per valanghe polverose. 

Determinazione dell'area di distacco, dello spessore del distacco e della massa 
del distacco per la valanga densa 

L’area della zona di distacco deve essere valutata ai sensi della procedura utilizzata 
nell’applicazione del modello Voellmy-Salm. La massa del distacco viene calcolata dalle 
aree e dagli spessori di distacco delle singole aree di distacco parziali e dalla densità 
media della neve. L'ultimo valore dipende dalla regione climatica e dall'altitudine della 
zona di distacco. Le zone di distacco che vengono sovraccaricate da trasporto eolico di 
neve presentano tipicamente densità superiori rispetto alle zone sottovento.  

Regione climatica Altitudine 
 <= 2000 m > 3000 m 

Vallese, Grigioni 120-200 kg/m3 100-170 kg/m3 
Versante nordalpino 140-230 kg/m3 120-200 kg/m3 
Versante sudalpino 160-250 kg/m3 140-220 kg/m3 

Tabella 4: Valori indicativi per la densità media di neve fresca, in funzione della regione climatica e dell'altitudine. 
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Distanza di formazione e grado di sospensione per valanghe polverose  
 

Osservazioni di valanghe reali, supportate da riprese fotografiche, hanno dimostrato che 
una valanga polverosa può svilupparsi a partire da una valanga densa già dopo i primi 
300-500 m di percorso e muoversi con dinamica propria e notevoli pressioni (>1-2 kPa). 
È possibile parlare di vera e propria valanga polverosa a partire da densità medie della 
miscela aria e neve di circa 1.5-2 kg/m3 e altezze di 20 m, che significa almeno 10 kg di 
neve sospesa su ogni metro quadrato di valanga. In base alle conoscenze attuali, il grado 
di sospensione “s” della neve cresce proporzionalmente alla velocità della valanga 
radente. Di conseguenza, le valanghe polverose si sviluppano principalmente da grandi 
valanghe dense piuttosto che da piccole valanghe dense. 

Regione climatica  Altitudine  
 < 2000 m 2000 - 3000 m > 3000 m 
Centro del Vallese, 
Engadina 

0.10 0.12 0.14 

Versante nordalpino 0.08 0.10 0.12 
Versante sudalpino 0.06 0.08 0.10 
 

Tabella 5: Valori indicativi per il grado di sospensione (rapporto tra la massa in sospensione e la massa originale del 
distacco) dopo una distanza di scorrimento di 300 m in funzione della regione climatica e dell'altitudine. 

 

3.3 Determinazione dei parametri di erosione SL-1D 

Una importante condizione al contorno è la quantità di neve che la valanga può erodere 
lungo il percorso e nella zona di arresto, ammesso che la valanga polverosa eserciti una 
forza sufficiente per l’erosione. SL-1D utilizza l’altezza di neve erodibile per limitare la 
massima quantità di neve che può essere erosa durante il calcolo; SL-1D necessita 
inoltre di un indice “e” per l'erodibilità della superficie del manto nevoso (vedere figure in 
basso).  
 
È possibile presupporre che nella maggior parte dei casi le valanghe polverose non 
erodano la neve vecchia. Per i singoli segmenti della traiettoria della valanga occorre 
specificare la quantità di neve fresca presente (spessore della neve fresca), la sua 
densità e l'entità della cosiddetta erodibilità (Erodibility). In riferimento alle probabili 
densità della neve, la seguente tabella offre alcuni suggerimenti. 
 
I valori indicativi per l'erodibilità sono suddivisi in due gruppi: quelli per regioni 
caratterizzate da nevicate asciutte e relativamente fredde (centro del Vallese, Engadina, 
versante nordalpino) e quelli per regioni caratterizzate invece da nevicate più umide e 
calde (versante sudalpino, esclusi Vallese ed Engadina). Per le regioni che si trovano 
nelle aree di passaggio occorre eventualmente fare un'interpolazione tra i valori attigui. 
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Tabella 6: Dipendenza dall'altitudine e dalla regione climatica della velocità di soglia per l'erosione della neve "e" nelle 
valanghe polverose, per periodi di ritorno di 30 (alto), 100 (centro) e 300 (basso) anni. Si tratta di valori indicativi che 

devono essere adeguati alle condizioni climatiche ed eoliche locali. 

3.4 Determinazione approssimativa della traiettoria di valanghe 
polverose 

Con la seguente procedura verranno determinati i dati topografici di input necessari per 
SL-1D). La seguente procedura dovrebbe anche evidenziare se la topografia dovesse 
essere troppo complessa per una simulazione monodimensionale. 

1. Conoscenza del terreno. Consultazione del catasto ed eventuali inchieste tra la 
gente locale. Ricerca di tracce relative a precedenti valanghe dense e polverose: 
danni ad edifici, danni a foreste (larghi corridoi con vegetazione assente o 
nettamente più giovane rispetto a quella circostante; alberi giovani con chioma 
spezzata; gruppi di alberi privi di rami sino ad altezze superiori a 10 m; rami 
sparsi non originari dell'ambiente immediatamente circostante, ecc.). 

2. Determinazione della traiettoria della valanga densa. Utilizzando le 
informazioni di cui ai punti 1. e 2. e mappe topografiche in scala 1:10.000 o 
1:5.000. La linea di massima pendenza vale come prima approssimazione; in 
presenza di aree non canalizzate la traiettoria è determinata da eventuali elementi 
morfologici che possono deviare la valanga densa. 

3. Possibili punti della traiettoria in cui lo strato polveroso  si separa dallo 
strato denso:  

o netta curvatura del canalone in cui scorre la valanga densa;  
o terreno estremamente pianeggiante, la valanga densa rallenta o si arresta; 
o la valanga densa supera un salto di livello e si trasforma in valanga 

polverosa.  
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4. Valutazione dei possibili punti di separazione localizzati tra zona di distacco 
e di deposito:  

o Curva del canalone, livellamento del terreno: lo strato di polvere si è già 
sufficientemente sviluppato per potersi separare dallo strato di 
scorrimento? Affinché ciò sia possibile è necessario un tratto di almeno 
300-500 m a partire dalla zona di distacco; se all'interno della traiettoria è 
presente neve poco erodibile oppure se l'erodibilità e è elevata (cfr. 
Determinazione dei parametri di erosione), questa distanza deve essere 
aumentata fino a circa 1 km.  

o Curva del canalone: procedere ad una valutazione grossolana dell'altezza 
di flusso HSL e della velocità USL della valanga polverosa all'interno del 
canalone; determinare l’angolo di deviazione δ della curva, l’altezza della 
scarpata hRunse e l’angolo della scarpata ψRunse del fianco del canalone. 
 
HSL > hRunse, δ > 30°: la parte più grossa della componente polverosa 
lascia il canalone, l'angolo di deviazione ε della valanga polverosa 
diminuisce all’aumentare di δ e aumenta con ψRunse. 
 
HSL < hRunse, USL2 > 2 g hRunse: una parte della valanga polverosa segue il 
canalone, il resto lascia il canalone; la parte che lascia il canalone cresce 
proporzionalmente a USL2/(2ghR) e δ/ψRunse (valori indicativi: 30-70% della 
massa della valanga polverosa).  

o Superamento di un salto di livello: se altezza di caduta » altezza di flusso, 
si assume che tutta la massa della valanga passi in sospensione. La 
valanga polverosa, a partire dal punto di impatto, continua a muoversi 
lungo la linea di massima pendenza. In presenza di un'altezza di caduta 
inferiore si assume che la componente polverosa continui a seguire la parte 
densa, ma che il 10-50% della massa della valanga densa passi in 
sospensione. 

5. Proseguimento della traiettoria della valanga polverosa a partire dal 
punto di separazione in prima approssimazione rettilineo. Sono necessarie 
correzioni sulla linea di massima pendenza, laddove l'altezza di dorsali, canaloni 
più piccoli, ecc., superi all'incirca di un quarto l'altezza stimata della valanga 
polverosa. L'angolo di deviazione scende con l'aumentare della velocità della 
valanga.  

6. Valutazione della larghezza della valanga polverosa. Lungo la traiettoria 
definita vengono localizzati elementi morfologici che possono limitare lo sviluppo 
laterale della valanga polverosa, p.es. fianchi di vallate o, in presenza di valanghe 
polverose più piccole, anche foreste. 
La larghezza approssimativa della valanga polverosa b(l), è determinata a partire 
dal punto iniziale della traiettoria della valanga polverosa (di norma 300-500 m 
sotto la zona del distacco) disegnando lungo di essa una linea che si estende con 
db/dl = 0.2. Possibili limitazioni date dal terreno hanno tuttavia la precedenza. Nei 
punti della traiettoria caratterizzati da una curvatura fortemente convessa 
(fondovalle stretto), la valanga polverosa si espande ulteriormente.  

7. Decisione sulla fattibilità del calcolo:  
o La valanga si lascia caratterizzare in modo sufficientemente chiaro?  
o Nella traiettoria della valanga polverosa non ricorrono troppe brusche 

variazioni di direzione o di pendenza? 
8. Elaborazione del profilo della traiettoria: lungo la traiettoria della valanga 

polverosa precedentemente individuata viene determinato il profilo morfologico 
dalla carta geografica (eventualmente con l'ausilio di un GIS). Le distanze tra i 
punti di appoggio da rilevare si basano sulla topografia; nel profilo dovrebbero 
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essere considerate variazioni di pendenza superiori a 2-3°, mentre distanze tra i 
punti di misurazione inferiori a 100 m o superiori a 500 m sono inopportune. 

9. Parametri della neve: in funzione della regione climatica, dell'altitudine e 
dell'esposizione al vento, viene determinata l'altezza della neve erodibile nei 
singoli segmenti della traiettoria. 

 

3.5 Parametri di calcolo SL-1D 
 
Parametri di calcolo (Calculation Parameters... → Powder Snow ) 
 
Per il calcolo di valanghe polverose è necessario impostare i seguenti cinque parametri:  

• Max Time: durata della simulazione. A seconda della lunghezza del tracciato e 
delle dimensioni della valanga sono consigliabili valori compresi fra 50 e 200 s. La 
simulazione si interrompe non appena viene raggiunto e/o superato il tempo 
impostato nel campo Max Time.  
Contrariamente a FL-1D, per ogni time step SL-1D sceglie autonomamente 
l'intervallo di tempo δt entro il range predefinito (l’utente non deve più introdurre 
il time step come per il modello delle valanghe dense). Se  il time step scende 
sotto 1 ms (nella versione 0.5.10), significa che è presente un'instabilità numerica 
e il calcolo viene interrotto.  
Il tempo di calcolo necessario per una simulazione è proporzionale al tempo Max 
Time, di conseguenza è sufficiente far arrivare la simulazione pochi secondi oltre 
l'istante in cui il fronte della valanga passa nel punto interessato. L’evoluzione dei 
dati di pressione in corrispondenza a questo punto (Time Plot → Pressure)  
permette di verificare se il valore massimo di pressione è stato effettivamente 
superato. Nelle topografie con contropendenze non è raro l'insorgere di instabilità 
con SL-1D v.0.5.10, se il valore di Max Time è troppo alto.  

• Dump Interval: non appena il tempo della simulazione raggiunge o supera i 
valori n · δtdump con n = 0, 1, 2, ..., per ogni punto della griglia vengono 
memorizzati nel file di output i valori di tutte le variabili di campo (ovvero h1, ρ1, 
h2, u2, ρ2, h3, u3, ρ3, k e ε).  
 
Le dimensioni del file di output (e quindi la necessità di memoria e di tempo 
richiesto per la rappresentazione dei risultati) è inversamente proporzionale al 
valore contenuto nel campo Dump Interval. Intervalli di tempo troppo lunghi 
fanno sì che p.es. la pressione massima non venga rilevata in un determinato 
punto. Per questo motivo è consigliabile impostare valori di 1-2 s per simulazioni 
con carattere sperimentale e di 0.5-1 s per valutazioni conclusive.  

• Element Size: la dimensione delle maglie δx della griglia di calcolo influisce sulla 
simulazione. È necessario tenere presente che la qualità dell'approssimazione 
numerica cresce con il diminuire della dimensione delle maglie. In generale 
un'ampia convergenza dei risultati si ottiene per δx < 5-10 m. Con maglie di 
lunghezza nettamente superiore a 10 m, le pressioni massime risultano troppo 
basse (sino al 50%).  
 
Occorre inoltre tenere presente che in SL-1D v.0.5.10 è fissato un limite massimo 
di 2048 punti. Si consiglia quindi di selezionare δx > L /1500, in cui L è la distanza 
cartografica in linea d'aria tra punto iniziale e punto terminale. La memoria su 
disco fisso e la memoria RAM utilizzate durante il calcolo sono  inversamente 
proporzionali a δx, ma tuttavia l’utilizzo della RAM non raggiunge quasi mai valori 
critici. Simulazioni tipiche generano file di output di dimensioni comprese fra 0.5 e 
10 MB. Poiché anche il valore del time step è inversamente proporzionale a δx, il 
tempo di calcolo quadruplica se viene dimezzata la lunghezza delle maglie.  
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• Maximal Deviation: la spezzata definita sulla base dei punti immessi viene 
livellata per ottenere un andamento della traiettoria più realistico e più 
conveniente ai fini dei calcoli. Nel corso di tale livellamento gli angoli della 
spezzata vengono "tagliati", cosicché la traiettoria modificata non scorre più 
esattamente lungo i punti immessi. Il valore specificato nel campo Maximal 
Deviation determina di quanto la curva livellata si può distanziare dai punti 
immessi. Di norma si consiglia di scegliere valori compresi fra 5 e 10 m. In 
presenza di topografie molto pianeggianti questi valori possono essere inferiori, 
mentre in presenza di traiettorie con brusche variazioni di pendenza e di direzione 
valori più alti possono eventualmente migliorare la stabilità della simulazione.  

• Cell Cut-Off: dopo ogni time step SL-1D disattiva le celle di calcolo nella coda 
della valanga in cui il flusso di massa e la quantità di moto sono  scese sotto un 
determinato limite sia nello strato di saltazione che in quello di sospensione. Il 
fronte della valanga attiva invece costantemente altri punti della griglia. Con la 
funzione Cell Cut-Off è possibile impostare questo limite. 

• Show Spline: attraverso il pulsante Show Spline è possibile visualizzare la 
traiettoria livellata e l'andamento della sua curvatura. 

 

3.6 Esecuzione dei calcoli con SL-1D 

In questo capitolo vengono presentate alcune avvertenze generali da osservare con 
particolare attenzione durante i calcoli numerici. I seguenti principi valgono anche per 
altri modelli di calcolo.  

1. Le simulazioni devono essere sempre ben documentate, in particolare con 
riferimento ai parametri utilizzati.  

2. Verifica dei valori immessi, soprattutto della topografia.  

3. Studio delle varianti: dapprima modificare singolarmente i parametri nell'ambito 
dei valori indicati dalle tabelle di calibratura, adeguandoli alle condizioni locali. 
Procedere successivamente al calcolo del "worst case", impostando 
contemporaneamente tutti i parametri ai valori estremi, dai quali risultano le 
pressioni maggiori.  

4. Eventuale esame di traiettorie alternative, se sussistono incertezze sulla selezione 
della traiettoria corretta.  

5. Verifica della convergenza:  

o Alcune variabili presentano oscillazioni fisicamente non plausibili?  

o Durante l'intera simulazione, tutti i valori rientrano nel range atteso?  

o I risultati variano notevolmente (cioè oltre il 5% circa) se il numero delle 
celle di calcolo viene raddoppiato? In caso affermativo, continuare ad 
aumentare il numero di celle sino a quando le variazioni si riducono 
sufficientemente. Griglie con maglie di larghezza inferiore ai 5 m sono 
tuttavia inopportune. In presenza di programmi senza adeguamento 
automatico della lunghezza dei time step, il valore δt deve essere 
sufficientemente piccolo per ottenere simulazioni stabili. 

 

3.7 Valutazione dei risultati del calcolo SL-1D 

In questa fase conclusiva è di fondamentale importanza il know-how dell'esperto. 
Considerando che l'esperienza e la conoscenza delle valanghe polverose è ancora limitata 
ed esiste un esiguo numero di casi esemplificativi ben documentati, è necessario seguire 
il seguente principio:  
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Per la rappresentazione cartografica delle zone soggette al pericolo di 
valanghe polverose è necessario prevedere adeguati margini di 
sicurezza durante la scelta dei parametri.  
 
Se le informazioni catastali o anche le valutazioni dell'esperto 
suggeriscono che il pericolo può essere maggiore di quello indicato dai 
calcoli, occorre utilizzare la valutazione più pessimistica. 

I suggerimenti seguenti possono supportare l'esperto in caso di incertezze nella 
valutazione. In ogni caso le precedenti regole devono sempre essere rispettate.  

• Confronto con casi noti.  

• Valutazione critica dei parametri di simulazione più probabili: la probabilità che più 
parametri statisticamente indipendenti tra di loro assumano contemporaneamente 
valori estremi è minima. Valori medi scelti con giudizio e razionalità portano molto 
probabilmente a un risultato ragionevole. 

• Determinazione indipendente dei valori iniziali o valutazione dei risultati della 
simulazione da parte di altri esperti. 

• Consulenza da parte dell'Istituto SNV o di altri esperti: se il dispendio è 
giustificato dall'entità del rischio, le simulazioni tridimensionali possono fornire 
ulteriori soluzioni. L'Istituto SNV è inoltre estremamente interessato a ricevere un 
ampio feedback dai professionisti, al fine di migliorare i metodi e i programmi di 
calcolo. 

 

3.8 Il programma per valanghe polverose SL-1D 

Principi implementati nel modello 

 

Figura 2: presentazione di una valanga polverosa 

 
Nel modello SL-1D sono stati implementati i seguenti principi:  

• La valanga polverosa viene considerata come una corrente stratificata di una 
miscela di neve e aria: sotto, lo strato di saltazione con una densità relativamente 
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alta (stimata 10-50 kg/m3) e uno spessore esiguo (< 5 m); sopra, lo strato in 
sospensione che nella maggior parte dei casi presenta una densità molto più 
bassa (< 10 kg/m3) e uno spessore che aumenta nel corso della discesa verso 
valle. La densità dipende dalla concentrazione locale di neve.  

• La valanga radente originale, dalla quale si forma la valanga polverosa, è 
ignorata. 

• Il moto della valanga è governato dalle componenti gravitazionali parallele al 
pendio. 

• Tra il manto nevoso e lo strato di saltazione, come pure tra lo strato di saltazione 
e quello in sospensione, è possibile uno scambio di neve. In prossimità della 
superficie dello strato di saltazione, la valanga si mescola con l'aria.  

• Gli scambi di massa tra il manto nevoso e tra gli strati della valanga sono 
governati da specifiche forze di attrito, alle quali si aggiungono forze di attrito 
aerodinamiche.  

• Lo strato di saltazione nella valanga viene modellato analogamente allo strato di 
saltazione caratteristico dei processi eolici della neve. Le particelle di neve che 
costituiscono questo strato rimbalzano ripetutamente sul terreno. L'altezza e la 
durata della saltazione dipendono dalla velocità. Le particelle di neve che 
colpiscono il manto nevoso possono arrestarsi, continuare a saltare o anche 
trascinare con sé altre particelle. Si presuppone che la quantità media di particelle 
che "decollano" per ogni particella che "atterra" sia una funzione dell'energia 
media di impatto e quindi della velocità media all'interno dello strato di saltazione. 
Ad ogni impatto una  parte della quantità di moto posseduta dalle particelle viene 
trasmessa al manto nevoso, sottoforma di attrito. 

• Alla perdita di quantità di moto provocata dall’ impatto tra la particella e il 
terreno, si contrappongono la forza gravitazionale e la forza aerodinamica di taglio 
dello strato in sospensione. Nella fase iniziale in cui si forma la valanga polverosa, 
lo strato di saltazione trascina con sé lo strato superiore in fase di formazione.  

• Lo scambio di massa tra lo strato di saltazione e quello in sospensione è 
proporzionale al bilancio tra le forze gravitazionali che tendono a far cadere le 
particelle e il trasporto turbolento di massa dallo strato più denso a quello meno 
denso. Per portare e mantenere in sospensione le particelle di neve, viene 
consumata energia turbolenta. 
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Figura 3: struttura degli strati e termini di scambio in SL-1D 

La figura 3 mostra la struttura degli strati e i principali termini di scambio in SL-1D. La 
coordinata s segue la traiettoria della valanga, z è invece perpendicolare ad essa. Gli 
indici 1, 2, 3 si riferiscono al manto nevoso, allo strato di saltazione e allo strato di 
sospensione. Ui sono le velocità mediate lungo lo strato in questione. I termini di scambio 
delle masse Q... inducono tensioni di taglio τp in prossimità dei limiti tra gli strati, alle 
quali si aggiungono contributi aerodinamici τf. 

Limiti di SL-1D, risoluzione dei problemi 

Questo capitolo offre una panoramica dei limiti più rilevanti di SL-1D. Alcuni di questi 
punti verranno risolti nelle future versioni del programma, altri sono limiti delle 
simulazioni numeriche e/o del modello selezionato.  

• Incertezza dell'input: nella maggior parte dei casi le condizioni iniziali sono 
scarsamente note, soprattutto nel caso di previsioni per determinati tempi di 
ritorno. Assunzioni irreali portano quasi sempre a risultati insensati. La plausibilità 
dei valori simulati deve quindi sempre e senza alcuna eccezione essere verificata 
da un esperto.  

• Nessuna modellazione dello strato di scorrimento: lo strato di saltazione in SL-1D 
riproduce alcune delle proprietà più rilevanti dello strato compreso tra strato di 
scorrimento (parte densa della valanga) e lo strato polveroso (parte polverosa 
della valanga). Non è tuttavia semplice valutare quale percentuale della massa 
che costituisce il lastrone di neve iniziale potrà essere attribuita allo strato di 
saltazione. Inoltre non viene modellata neanche la marcata influenza (almeno 
nella fase iniziale) della parte densa sullo strato di saltazione. Di volta in volta 
occorre valutare in quale direzione questa interazione modificherebbe i risultati 
della simulazione.  
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• Distribuzione idrostatica della pressione: con questo tipo di modello, che media le 
velocità di flusso sull’altezza della valanga, il moto turbolento e caratteristico delle 
valanghe polverose non può essere riprodotto in modo soddisfacente. I profili di 
velocità o di densità sono quindi introdotti separatamente tramite l’utilizzo di 
specifiche funzioni. La descrizione matematica di questi profili si adatta alla 
descrizione del moto all’interno del corpo della valanga ma non si adatta 
altrettanto bene alla descrizione del moto del fronte della valanga. Poiché, la 
pressione di ristagno in prossimità del fronte della valanga causata dallo 
spostamento d'aria non è considerata, si verificano: un eccessivo assottigliamento 
della testa della valanga, il raggiungimento di velocità troppo elevate e un lento 
rallentamento della valanga. Nella simulazione, le pressioni massime si verificano 
nel corpo della valanga invece che nella testa.  

• La larghezza del flusso viene ignorata: l’espansione laterale della valanga in un 
pendio aperto o all'uscita di un canalone produce una riduzione della densità, della 
velocità, delle altezze di flusso e conseguentemente anche della pressione. In una 
simile situazione, i risultati di SL-1D sono "conservativi". L'esperto deve 
opportunamente considerare tale circostanza. Casi difficili devono in questo caso 
essere studiati mediante l’ausilio di modelli tridimensionali. 
AVAL-1D e SL-1D sono strutturati in modo tale da rendere possibile, in futuro, la 
definizione della larghezza della traiettoria. Alcuni dei problemi più frequenti che si 
verificano con l'impiego di SL-1D, incluse le relative soluzioni, sono riportati nelle 
FAQ. Qui di seguito alcune ulteriori avvertenze: 

• La densità del manto nevoso non deve essere pari a 0 in nessun punto, altrimenti 
si verificherebbero delle instabilità.  

• La soglia per l'attivazione e/o disattivazione delle celle di calcolo può essere 
variata. Il valore di default è consigliato per valanghe di dimensioni da medie a 
grandi. In presenza di valanghe molto piccole questo valore deve essere ridotto, 
altrimenti tutte (o quasi tutte) le celle vengono disattivate dopo il primo time step. 
In presenza di valanghe molto grandi, un valore più elevato può migliorare la 
stabilità e ridurre la lunghezza visibile della valanga (questa riduzione è del tutto 
irrilevante per i risultati).  

• Contrariamente al modello FL-1D, nel modello SL-1D i parametri di input come 
altezza del manto nevoso, erodibilità della neve, ecc. non vengono immessi 
segmento per segmento, ma punto per punto. Per ottenere un evidente limite di 
passaggio tra la zona di distacco e la zona di scorrimento, è necessario 
aggiungere un punto di controllo a circa 10 m sotto il piede del lastrone. Sino al 
punto corrispondente al piede del lastrone valgono le condizioni di distacco, al di 
sotto valgono quelle per il manto nevoso originale. AVAL-1D offre a questo scopo 
la funzione 
Edit → Edit Topography → Interpolate.  

• Se i punti vengono selezionati troppo vicini tra di loro, piccole imprecisioni nella 
determinazione dei punti possono causare errori nella determinazione della 
curvatura del tracciato che pregiudicano la stabilità del calcolo. Con la funzione 
Edit → Calculation Parameters… → Powder Snow → Show Spline è possibile 
visualizzare la curvatura nei punti della griglia. La curvatura dovrebbe avere un 
valore massimo di 0.01 1/m e non oscillare eccessivamente. All'occorrenza è 
necessario rimuovere i punti superflui.  
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4 Immissione dei punti del profilo (Edit Topography) 
 

La topografia della valanga può essere immessa in tre modi diversi: 

1. leggendo i dati dalla carta geografica e immettendoli punto dopo punto 
attraverso una finestra di dialogo; 

2. scrivendo i dati in una tabella di Excel e leggendo direttamente la tabella; 
3. leggendo la topografia direttamente da una cartina digitale. I riferimenti 

geografici della cartina possono essere eseguiti in AVAL-1D oppure essere 
importati da ArcView. 

 
 
La finestra di dialogo "Edit Topography"  

 

• X-Coordinate (m): la coordinata X del punto 
evidenziato in metri. 

• Y-Coordinate (m): la coordinata Y del punto 
evidenziato in metri. 

• Z-Coordinate (m): altitudine sul livello del mare 
del punto evidenziato in metri. 

• Width (m): larghezza valanga in metri. 
• Endmark? Demarcazione della massima distanza 

di arresto della valanga osservata. Con i tasti 
freccia spostarsi sul punto più estremo della 
valanga osservata (massima distanza di arresto)  e
impostare Endmark? su YES. Questa 
demarcazione può essere impostata una volta 
sola! 

• M. Point? Immissione e controllo dei punti di 
monitoraggio. Il numero di punti di monitoraggio è 
illimitato. 

• Interpolate per aggiungere punti interpolati 
prima e/o dopo il punto evidenziato, oppure per 
aggiungere un punto per interpolazione tra due 
punti evidenziati.  

• Delete per cancellare il punto evidenziato dalla 
topografia. 

• New Left / New Right per aggiungere un nuovo 
punto a sinistra/destra del punto evidenziato. 

• Slope above (°): indica l'inclinazione del pendio a 
sinistra del punto evidenziato (in gradi). 

• Distance above (m): indica la distanza reale  in 
metri dal punto evidenziato al successivo punto 
sulla sinistra. 
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Lettura di una tabella 
 

 

 

• 1a riga: la riga di intestazione
deve includere uno dei 
termini: 
 
Topographie: 
Topography: 
Topografia: 
 
seguito da un nome che 
descrive la topografia (vedere 
a sinistra). 

• 1a colonna: coordinata X in 
metri 

• 2a colonna: coordinata Y in 
metri 

• 3a colonna: coordinata Z 
(altitudine s.l.m.) in metri 

• 4a colonna: larghezza 
valanga in metri 

• La tabella deve contenere 
almeno due righe di dati. 

 
 

 
Lettura di una cartina digitale 

Questa funzione permette di leggere  una cartina digitale, di metterla in riferimento con 
le coordinate geografiche di quattro punti qualsiasi, di selezionare successivamente un 
profilo valanghivo  e di leggerlo in AVAL-1D. 

ATTENZIONE: solo le coordinate geografiche vengono calcolate automaticamente con 
l'ausilio di una funzione di conversione, non l'altitudine sul livello del mare (assenza di un 
modello topografico digitale). Ciò significa che i punti topografici devono essere impostati 
esattamente sulle isoipse (= curve di livello). 
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Opzioni del menu Map Images: 
 

 

• Open Image: possibile la visualizzazione di immagini in 
formato GIF, TIFF, JPEG e BMP.  

• Zoom Image: un'immagine può essere ingrandita a 
piacere. Zoom Image ingrandisce la zona selezionata  di un 
fattore 2. 

• Reload Original Image: attivare questo pulsante per 
ripristinare l'immagine originale. 

• Register Image: funzione per georeferenziare  la cartina, 
sulla base  di quattro punti. 

• Create Topography: selezionare questa opzione per creare
la topografia.  

• Print Image: per stampare la topografia. 
• Delete Image: se è stata selezionata un'immagine non 

corretta, con questa funzione è possibile cancellarla e aprire 
una nuova immagine. 

• Cancel: selezionando Cancel si torna ad AVAL-1D senza 
specificare alcuna topografia. 

• Show Topography: per visualizzare la topografia 
selezionata in AVAL-1D. 
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5 Help - Properties  
 

Proprietà generiche come, per esempio, dimensioni dei caratteri, spessore delle linee, 
uscita stampante, directory di lavoro, etc. possono essere modificate e salvate con la 
funzione Track → Properties. Questa funzione può essere richiamata anche premendo il 
tasto destro del mouse.  
Tutte le proprietà vengono salvate nel file properties.dat nella directory 
~\Rsi\Idl52\lib\hook. Ogni volta che viene avviato AVAL-1D, il programma legge 
questo file e imposta le proprietà selezionate. 

 

Di seguito alcune spiegazioni sulle possibili impostazioni contenute nel file 
properties.dat (SL: valanghe polverose, FL: valanghe dense): 
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Scaling Factors:  
--------------- 
 
50.0000  
30.0000  
2.00000  
16.0000  
3.00000  
0.500000  
0.500000  
5.00000  
50.0000  
 
General Properties:  
------------------ 
 
1.00000  
0.800000  
1.00000  
2.50000  
0.000000  
0.000000  
1274.00  
578.667  
1274.00  
289.333  
30.0000  
14.0000  
1.00000  
lpt1  
C:\Programme\aval\ava\  
C:\Programme\Netscape\netscape.exe  
1.00000  
1.00000  
1.00000 
3.00000 
0.00000 
0.00000*  

Scaling Factors: 
---------------  
 
Fattore dello strato di neve erodibile (SL) 
Fattore dello strato di saltazione (SL) 
Fattore dello strato in sospensione (SL) 
Fattore dello strato di neve (FL) 
Fattore della velocità (FL) 
Fattore della pressione (FL) 
Offset della massima altezza del manto nevoso (FL) 
Offset della velocità massima (FL) 
Offset della pressione massima (FL) 
 
General Properties: 
------------------ 
 
Dimensione caratteri del titolo 
Dimensione caratteri della legenda e delle scritte 
Spessore delle linee a video 
Spessore delle linee per la stampa/file EPS 
Attivazione (1.0) e disattivazione (0.0) della legenda 
Attivazione/disattivazione altri parametri SL 
Larghezza della finestra in pixel 
Altezza della finestra superiore in pixel 
Larghezza della finestra in pixel 
Altezza della finestra inferiore in pixel 
Pressione limite tra zona rossa e zona blu  
Dimensione caratteri delle finestre di dialogo 
Attivazione/disattivazione limite di pressione rosso 
Uscita stampante 
Directory di lavoro 
File *.exe del browser Internet 
Punti selezionati visibili/nascosti (immissione) 
Linee verticali della griglia visibili/nascoste 
Linee orizzontali della griglia visibili/nascoste  
Pressione limite tra zona blu e zona bianca 
0: Help in lingua tedesca, 1: Help in lingua inglese 
Attivazione/disattivazione dell'opzione "Volume del 
distacco"  

 
* Questo parametro può essere modificato aprendo il file 'properties.dat' con un editor di 
testo (p.es. Wordpad).  
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Offsets 

Per comprendere il significato di offset osservare attentamente la figura sottostante:  

 

Spiegazione: per "offset" si intende la differenza tra il valore massimo della curva (p.es. 
delle altezze del manto nevoso) e il valore massimo dell'asse Y. Se la simulazione 
raggiunge un'altezza del manto nevoso massima di 3.1 metri e l'offset per l'altezza del 
manto nevoso è impostato su 0.5 metri, l'asse Y si estende da 0 a 3.6 metri (vedere la 
figura sopra). 
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Attivazione/disattivazione altri parametri SL   

Attraverso il checkbox 'Show All Powder Snow Parameters' è possibile attivare e 
disattivare i parametri relativi allo strato in sospensione. Di default questi parametri sono 
disattivati, dal momento che nella maggior parte dei casi non vengono utilizzati.  

 
 

 

 

 

 

 
 
Uscita stampante  

Di norma le stampanti vengono collegate al computer attraverso una connessione 
parallela (detta anche connessione LPT). Il programma AVAL-1D è impostato di default 
sulla connessione 2 (LPT2). Se la stampante è invece collegata alla porta LPT1 oppure se 
viene utilizzata una stampante di rete, non è p.es. possibile stampare il file di log o il file 
di info. Per sapere a quale porta è collegata la stampante, procedere come segue (se 
questa informazione è nota, specificare la porta corretta nel campo Printer Port):  

Windows 95/98:  
aprire Avvio → Impostazioni → Stampanti, evidenziare la stampante collegata al PC e 
selezionare File → Proprietà. Successivamente selezionare la scheda Dettagli e copiare 
l'impostazione del campo "Stampa su:" nel campo Printer Port della finestra di dialogo 
Properties.  
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Windows 2000: 
Aprire Avvio → Impostazioni → Stampanti, evidenziare la stampante collegata al PC e 
selezionare  
File → Proprietà. Successivamente selezionare la scheda Porte e tenere a mente 
l'impostazione del campo "Porte". L'impostazione di questo campo dovrebbe essere simile 
a questa: server:nomestampante. Successivamente immettere nel campo Printer Port 
quanto segue: \\server\nomestampante 
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Attivazione/disattivazione dell'opzione "Volume del distacco"  

 

  
0.0 in properties.dat: 

 
1.0 in properties.dat: 

 

 
 
 
Directory di lavoro  

Attraverso il campo "Working Directory" esiste la possibilità di selezionare una 
directory di lavoro. Fare clic sulla freccia per specificare la directory. Premere sul 
pulsante "Save Properties" per confermare e memorizzare la nuova impostazione.  

 
 
 
Browser Internet  

Per visualizzare questo menu di Help, AVAL-1D necessita di alcune informazioni sul 
browser Internet.  
 
Per esempio: 
Microsoft Internet Explorer → C:\Programmi\Internet Explorer\iexplore.exe 
Netscape Communicator 
→C:\Programmi\Netscape\Communicator\Program\netscape.exe  

Fare clic sulla freccia per cercare il relativo file *.exe. Premere sul pulsante "Save 
Properties" per confermare e memorizzare la nuova impostazione.  
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6 News - Update 1.2 – News 
 

• Generalità: 
• Tutti i vecchi file di input e i file contenenti le simulazioni possono essere letti 

anche nella nuova versione. 
• Menu di Help disponibile in tedesco, inglese e italiano (vedere Properties). 
• Il menu Properties è stato ampliato con le seguenti opzioni: 
• linee orizzontali e verticali della griglia visibili/nascoste, 
• informazioni lungo la traiettoria della valanga richiamabili ancora più rapidamente, 
• Input: la selezione dei punti può essere visualizzata o nascosta. 
• Valanga radente: 
• perdita/aggiunta di masse di neve lungo la traiettoria, 
• i monitoring point sono selezionabili direttamente, 
• gli input-point possono essere visualizzati sotto forma di punti rossi, 
• µ e ξ visualizzabili nella finestra inferiore. 
• Valanga polverosa: 
• immissione della massa di distacco semplificata. 

 
 
New: le informazioni lungo la traiettoria sono richiamabili ancora più rapidamente.  
 

Fare clic con il pulsante sinistro del mouse in prossimità di qualsiasi punto 
per visualizzare le relative informazioni (il punto viene visualizzato in 
verde). Le stesse informazioni possono anche essere richiamate attraverso 
l'opzione Points →Print Selected Point Info. 
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New: gli input-point possono essere visualizzati sotto forma di punti rossi.  
 

Attraverso l'opzione Points → Draw/Remove Input Points è possibile 
visualizzare gli input-point per nuovi file di simulazione (i punti vengono 
visualizzati in rosso).  

 

 
 
 
New: i monitoring point sono selezionabili direttamente.  
 

Attraverso il tasto destro del mouse → Select Monitoring Points (o 
Points → Select Monitoring Points) è possibile selezionare i monitoring 
point e p.es. valutare l’andamento della velocità con la funzione Time Plot 
→ Velocity.  

 
 
 
New: µ e ξ possono essere visualizzati nella finestra inferiore. 
 

Attraverso l'opzione Track Plot → Show Xi (Input Parameter) o → 
Show Mu (Input Parameter) i valori ξ e µ possono essere visualizzati 
nella finestra inferiore.  
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New: linee orizzontali e verticali della griglia visibili/nascoste. 
 

Le linee orizzontali e verticali della griglia possono essere visibili o nascoste 
attivando o disattivando il relativo checkbox in Track → Properties.  
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New: Input: la selezione dei punti può essere visualizzata o nascosta. 
 
 

La sezione degli input point può essere visualizzata o nascosta attivando o 
disattivando il relativo checkbox in Track → Properties. 

 
 

 

  

 

 
 
 
New: riduzione/aggiunta di masse di neve lungo la traiettoria. 
 

Esempio: a partire da una quota di 1600 m s.l.m. la valanga si divide in 
due tronchi. Una valutazione sommaria dell'esperto indica che il 60% della 
massa della valanga scorre in una direzione e il 40% nell'altra. Questo 
problema può ora essere risolto! 
 
Procedura: 
creare i due profili corrispondenti ai due tronchi di valanga. Effettuare 
dapprima un calcolo normale per entrambi i profili utilizzando l'intera 
massa di distacco. Aprire la prima simulazione. Dalla simulazione viene a 
questo punto esportato un file di input che include le altezze del manto 
nevoso e le velocità corrispondenti all'istante in cui la valanga raggiunge la 
quota di 1600 m s.l.m. A questo proposito aprire Track → Export... → 
Simulation e immettere quanto segue: 
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Premere successivamente su Export per visualizzare il seguente 
messaggio: 

 

Premere su OK, chiudere la simulazione attiva e aprire il file di input 
track1_split.ava. Ripetere ora la simulazione e sovrapporre il risultato alla 
prima simulazione. Ora è possibile notare le differenze di velocità, 
pressione, altezze del manto nevoso e distanza di arresto sulla base della 
differente massa a partire da quota 1600 m s.l.m.  
 
Procedere in modo analogo per il secondo profilo, utilizzando però per 
l'esportazione solo il 40% (Fraction of snow height (0-1) = 0.4).  

Naturalmente è anche possibile aggiungere masse a partire da una 
determinata altitudine. A questo proposito è sufficiente specificare un 
valore superiore a 1.0 nell'opzione Fraction of snow height (0-1).  

 
 
New: immissione della massa di distacco semplificata. 
 

Sino alla versione 1.1 inclusa, i parametri di distacco di una valanga 
polverosa venivano specificati come segue: 

Per un d0=1.2m, una densità della neve fresca di 175kg/m3 e un grado di 
sospensione di 0.2, era necessario specificare: 

1.2m • 175kg/m3 • 0.2 = 1.0m • 42kg/m3 

 

A partire dalla versione 1.2 i parametri di distacco di una valanga 
polverosa vengono immessi in forma leggermente diversa (semplificata): 
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7 Supporto & FAQ 
In presenza di problemi tecnici o domande relative all'installazione o all'uso di AVAL-1D, 
non esitate a contattarci all'indirizzo  

aval1d@slf.ch  

o  

Tel.: +41 81 417 02 66  

 

FAQ (frequently asked questions):  

• Installazione 
• Generalità 
• Valanghe dense 
• Valanghe polverose 

 

7.1 FAQ  Installazione 
 

Problema: la finestra di AVAL-1D non rientra nello schermo!  
Problema: nonostante l'immissione del codice di installazione corretto, è impossibile 
avviare AVAL-1D!  

 
 
Problema: la finestra di AVAL-1D non rientra nello schermo! 
 

La procedura di installazione è stata conclusa senza problemi. Avviando per 
la prima volta AVAL-1D, non tutta la finestra del programma è tuttavia 
visibile sullo schermo.  

1° rimedio: spostare la finestra di AVAL-1D in modo da vedere l'angolo 
superiore destro della finestra. Premere sul simbolo centrale tra i tre 
presenti nell'angolo superiore destro (vedere freccia rossa nella figura 1) 
per aprire a tutto schermo la finestra di AVAL-1D.  

 
 

Figura 1: il simbolo centrale serve per aprire a tutto schermo la finestra del programma.  
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2° rimedio: solo per AVAL-1D vers. 1.0: selezionare Avvio → 
Impostazioni → Pannello di controllo → Display → Impostazioni e 
modificare la risoluzione dello schermo da 800x600 a 1024x768 pixel. Le 
dimensioni della finestra di AVAL-1D vers. 1.0 (dicembre '99) non possono 
essere variate manualmente, cosa che è invece possibile nella versione 1.1 
(marzo 2001).    

 
 
Problema: nonostante l'immissione del codice di installazione corretto, è impossibile 
avviare AVAL-1D! 
 

I codici di installazione devono essere specificati due volte solo al primo 
avvio di AVAL-1D. Se i codici non vengono specificati correttamente o se 
IDL non riesce a trovare la chiave elettronica (dongle), sullo schermo viene 
visualizzato il messaggio di errore illustrato nella figura 2.  

 

Figura 2: questo messaggio di errore viene visualizzato se viene specificato un codice di 
installazione errato o se il dongle non è installato correttamente.  

1° rimedio: verificare ancora una volta l'esattezza dei codici di 
installazione. Questi devono essere immessi ESATTAMENTE nello stesso 
formato in cui sono stati ricevuti!  

2° rimedio: sotto Windows NT4.0/2000, prima dell'installazione è 
necessario collegarsi come Amministratore, altrimenti non è possibile 
installare i driver della chiave elettronica. Se questa procedura è stata 
omessa, è necessario disinstallare AVAL-1D dal computer (Avvio → 
Programmi → AVAL-1D 1.2 → Uninstall AVAL-1D 1.2), collegarsi come 
Amministratore e ripetere l'installazione!  

3° rimedio: il dongle (= chiave elettronica) deve essere collegato direttamente alla 
porta parallela del computer e non tra il cavo della stampante e la stampante! 
 

 
 

7.2 FAQ – Generalità 
 

Problema: AVAL-1D non effettua alcun calcolo!  
Problema: i grafici esportati (jpg, gif o tif) sono in bianco & nero e non a colori!  
Problema: la cifra a fianco della barra Time Step indica i secondi?  
Problema: sebbene la cartina digitale sia stata georeferenziata , è impossibile 
specificare una topografia! 

 
 
Problema: AVAL-1D non effettua alcuna calcolo!  

Dopo l'avvio del calcolo non compare a video una finestra DOS nella quale 
vengono visualizzati i risultati relativi alle varie fasi di calcolo. Sia la 
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finestra superiore che quella inferiore sono nere. Neanche nel file di errore 
di AVAL-1D è possibile trovare dei riferimenti. Questo problema può 
verificarsi durante il calcolo di valanghe dense e anche polverose.  

1° rimedio: questo problema è molto probabilmente legato al fatto che il 
file di input si trova in una directory il cui nome include uno spazio (p.es. 
C:\Programmi\Aval\Progetto 57\val). Correggere quindi Progetto 57 con 
Progetto_57 e provare a rilanciare il calcolo.  

2° rimedio: se il primo rimedio non dovesse risolvere il problema, è anche 
possibile che siano state create troppe sottodirectory e che quindi il 
percorso sia troppo lungo. Se il percorso che conduce al file di input è più 
lungo di 100 caratteri, possono infatti verificarsi dei problemi. Copiare il file 
di input nella directory C:\Temp ed effettuare il calcolo su questo file. Se la 
simulazione viene conclusa con successo, significa che il nome del percorso 
era effettivamente troppo lungo.  

 

Problema: (solo versione 1.0) i grafici esportati (jpg, gif o tif) sono in bianco & nero e 
non a colori!  

I grafici in formato JPG, GIF e TIF possono solo essere esportati in bianco 
& nero e non a colori, vedere figura 3.  

 

 

Figura 3: visualizzazione di un file GIF esportato.  

1° rimedio: si tratta di un piccolo bug del programma. È tuttavia possibile 
risolverlo in questo modo: dal menu di Windows selezionare "Avvio → 
Impostazioni → Pannello di controllo → Video" e poi la scheda 
"Impostazioni" per impostare l'opzione "Colori" a 256 colori. Questa 
situazione non è certamente  ideale, ma attualmente quasi l'unica (vedere 
2° rimedio) per poter esportare i grafici a colori. I grafici dovrebbero inoltre 
essere esportati sotto forma di file GIF, dal momento che in un file JPG i 
colori non vengono riprodotti correttamente.  
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2° rimedio: è anche possibile esportare un grafico sotto forma di file EPS 
(Encapsulated PostScript). Questa soluzione permette di ottenere sempre 
disegni da plotter colorati, a condizione che la stampante disponibile 
supporti il formato "PostScript". I file in formato EPS importati in Word 
sono visibili solo sulla copia stampata e non direttamente sullo schermo. 

 
 

Problema: la cifra a fianco della barra scorrevole Time Step indica i secondi?  

A seconda del Dump Interval vengono memorizzati time step (= intervalli 
di tempo) variabili. Lasciando Dump Interval al suo valore di default di 1 
s, la cifra corrisponde effettivamente ai secondi (vedere figura 4). Se 
invece viene impostato un Dump Interval di 2 s, per ottenere i secondi la 
cifra deve essere moltiplicata per 2. Formula:  
numero time step * Dump Interval = secondi 

 
Figura 4: barra Time Step e  time step.  

Rimedio: selezionare Track Plot → Show Logfile e controllare su quale 
valore è impostata l'opzione Dump Interval.    

 
 

Problema: sebbene una cartina digitale sia stata geoferenziata, è impossibile specificare 
una topografia!  

Il world-file creato con Register Image e appartenente ad una cartina 
digitale viene sempre memorizzato nella stessa directory in cui si trova 
anche l'immagine stessa e  non può essere cancellato o spostato da questa 
directory.  

Rimedio: lanciare Gestione Risorse e aprire la directory in cui si trova la cartina digitale. 
In questa directory dovrebbe trovarsi anche il corrispondente world-file (le estensioni 
corrette sono specificate al punto 3.1.3, pag. 37 del Manuale Utente). In caso contrario, 
AVAL-1D non è in grado di trovare il file. A questo punto è possibile cercare il world-
file e spostarlo nuovamente nella directory corretta oppure è necessario impostare 
nuovamente i riferimenti dell'immagine. 
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7.3 FAQ – Valanghe dense 

Problema: la distanza di arresto nel file di log è inspiegabilmente lunga! 
Problema: AVAL-1D calcola forze di pressione in punti in cui la valanga non arriva!  
Problema: è impossibile stampare il file di log! 
Problema: il calcolo è insolitamente rapido e la valanga scorre in senso opposto sulla 
topografia! 
Problema: il calcolo si blocca dopo una o due iterazioni! 
Problema: il calcolo si blocca in seguito a instabilità numeriche! 
Problema: le instabilità numeriche si verificano con valanghe dense in prossimità del 
fronte della valanga (o non localizzabili) . 
Problema: le instabilità numeriche si verificano con valanghe dense nella parte superiore 
del percorso. 
Problema: scostamento notevole tra l'estremità del deposito e l'estremità della zona blu.  

 
 
Problema: la distanza di arresto nel file di log è inspiegabilmente lunga! 
 

Se la distanza di arresto della valanga nel file di log è inspiegabilmente 
lunga, ciò è da ricondursi molto probabilmente alla presenza di instabilità 
numeriche in prossimità del fronte della valanga. In questo caso si 
consiglia di esaminare con più attenzione le forze di pressione e le velocità 
al termine della simulazione (vedere rimedio del problema successivo). 

 
 
Problema: AVAL-1D calcola forze di pressione in punti in cui la valanga non arriva! 
 

La figura 5 illustra il tipico fenomeno causato dalla presenza di instabilità 
numeriche. Conclusa l'animazione della valanga, vengono visualizzate le 
forze di pressione e le velocità. 
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Figura 5: insolite forze di pressione in prossimità del fronte della valanga.  

Rimedio: ingrandire l'area in cui è presente l'instabilità numerica. Lanciare 
l'animazione con il comando Velocità (Track Plot → Velocity) e osservare 
con la massima attenzione la sezione ingrandita. Verso la fine 
dell'animazione il programma dovrebbe improvvisamente visualizzare una 
velocità incompatibile con la simulazione. Per localizzare con precisione 
l'esatto momento in cui si verifica l'instabilità, fare clic con il mouse sulla 
barra scorrevole Time Step e con i tasti freccia sulla tastiera muovere la 
barra aumentando o diminuendo i time step. Una volta localizzata 
l'instabilità, ripetere la simulazione utilizzando però come Max Time il 
tempo corrispondente all'instabilità, letto direttamente sulla barra 
scorrevole, ma diminuito di un secondo. 

 
 
Problema: è impossibile stampare il file di log! 
 

Versione 1.0:  
a seconda della porta alla quale è collegata la stampante, non è escluso 
che sia impossibile stampare il file di log. Per fare una verifica: aprire il 
Pannello di Controllo (Avvio → Impostazioni → Pannello di controllo) e 
selezionare Stampanti. Dovrebbe comparire una finestra nella quale sono 
elencate le stampanti impostate. Selezionare una stampante (fare un clic 
con il pulsante sinistro del mouse sulla stampante) e poi, con il cursore 
posizionato sulla stampante evidenziata, fare clic con il pulsante destro del 
mouse. Dal menù a tendina selezionare l'opzione Proprietà. A questo 
punto dovrebbe essere visualizzata a video una finestra contenente le 
proprietà della stampante selezionata. Selezionare Dettagli e accertarsi 
che l'opzione Stampa su: sia impostata su LPT2:. In caso contrario, è 
impossibile stampare il file di log da AVAL-1D. Anche in questo caso si 
tratta di un piccolo bug del programma!   

1° rimedio: per stampare p.es. il file di log del calcolo prova1.idl, se  non 
è possibile direttamente da AVAL-1D. Il file di log (prova1.dlg) può però 
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essere aperto p.es. in Word o in un altro editor di testo ed essere quindi 
stampato da qui (il file di log si trova nella stessa directory del file di 
calcolo).  

2° rimedio: nella versione aggiornata di AVAL-1D questo bug verrà 
eliminato!  

Versione 1.1:  
anche nella nuova versione di AVAL-1D non è escluso che sia impossibile 
stampare il file di log. Come risolvere il problema:  
 
1° rimedio: stampante locale: selezionare Track → Properties e nel 
campo Printer Port specificare la porta alla quale è collegata la stampante 
(in presenza di una connessione via interfaccia seriale, di norma si tratta 
della porta LPT1 o LPT2). Per ottenere questa informazione, selezionare 
Avvio → Impostazioni → Stampanti, evidenziare la stampante e 
selezionare File → Proprietà. Successivamente selezionare la scheda 
Dettagli e copiare l'impostazione del campo "Stampa su:" nel campo 
Printer Port (sotto Win2000 questa informazione si trova nella scheda 
Connessioni).  
2° rimedio: stampante di rete: se la stampa avviene attraverso una 
stampante collegata in rete, nel campo Printer Port è necessario 
specificare il server e il nome della stampante (p.es. \\server\laser_xy); 
eventualmente chiedere assistenza all'amministratore della rete. 
   

 
 
Problema: il calcolo è insolitamente rapido e la valanga scorre in senso opposto sulla 
topografia! 
 

Solo versione 1.0: la figura 6 mostra il risultato di un simile calcolo. Di 
norma il calcolo si interrompe dopo 5-10 iterazioni.  

 
Figura 6: risultato insolito di un calcolo.  
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Rimedio: molto probabilmente nell'area di distacco è stata specificata una 
larghezza della valanga = 0. Ciò non è ammissibile: impostare quindi la 
larghezza della valanga p.es. di "1.0 m". Lungo tutto il percorso , la 
larghezza della valanga non deve MAI essere pari a zero.    

 
 
Problema: il calcolo si blocca dopo una o due iterazioni!  

 
 

Solo versione 1.0: dopo una o due iterazioni, AVAL-1D si blocca e il 
messaggio illustrato nella figura 7 rimane fisso sullo schermo.  

 
Figura 7: questo messaggio non scompare più dallo schermo.  

Rimedio: lungo il profilo della valanga, una o più larghezze della valanga 
sono impostate su "zero". Correggerle p.es. a "1.0 m". Lungo tutto il 
percorso, la larghezza della valanga non deve MAI essere pari a zero.  
   

 
 
Problema: il calcolo si blocca in seguito a instabilità numeriche  

 
 

Questo problema si verifica solitamente in presenza di un profilo di valanga 
con variazioni estreme di inclinazione, soprattutto se si tratta di un profilo 
con una marcata contropendenza o di punti di passaggio tra inclinazioni di 
forma concava e convessa. Nel momento in cui si verificano problemi di 
carattere numerico, occorre localizzare il punto in cui si verifica l'instabilità. 
Di norma è possibile localizzare questo punto analizzando la velocità nei 
risultati del calcolo. Solitamente le instabilità numeriche si verificano in 
prossimità del fronte della valanga o nella parte superiore della sua 
traiettoria. Questi due casi vengono trattati dettagliatamente nei due 
problemi FAQ che seguono. 

 
 
Problema: le instabilità numeriche si verificano con valanghe dense in prossimità del 
fronte della valanga (o non localizzabili)  

 
 

Una tipica instabilità numerica in prossimità del fronte della valanga è 
illustrata nella figura 8. Non sempre queste instabilità sono facilmente  
localizzabili. Se nella rappresentazione delle velocità massime non è 
individuabile alcun picco di velocità anomalo, con l'ausilio della 
rappresentazione delle velocità occorre analizzare il terreno per ogni 
singolo time step e localizzare eventuali picchi di velocità o velocità 
negative. I metodi descritti qui di seguito dovrebbero essere utilizzati per 
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provare ad eliminare queste instabilità numeriche anche se non sono 
rilevabili.  

 
Figura 8: caratteristiche tipiche di un'instabilità in prossimità del fronte della valanga. L'instabilità è 
indotta dal brusco passaggio dal terreno pianeggiante alla contropendenza. A causa dell'instabilità 

numerica vengono generate velocità sino a oltre 800m/s.  
   
   

1° rimedio: riduzione del time step  

Il time step deve essere ridotto gradualmente. Ciò implica un tempo di 
calcolo più lungo per la simulazione. Per non dover rimanere in attesa dei 
risultati troppo a lungo, il criterio di limitazione temporale Max Time 
dovrebbe essere ridotto ad un tempo di circa 60s oltre quello in cui si 
verificano le instabilità numeriche. Si raccomanda di ridurre il time step in 
questa sequenza: 0.0025s, 0.001s, 0.0005s, 0.00025s sino a quando la 
simulazione si stabilizza . Nel caso si verificassero ancora instabilità anche 
con un time step di 0.00025s, procedere con il 2° rimedio.  

2° rimedio: livellamento della brusca variazione di pendenza nel terreno 
mediante l'immissione di altri punti  

Aggiungere rispettivamente un punto a sinistra e a destra della brusca 
variazione di pendenza, a una distanza di circa 10 m. Questa operazione 
può essere facilmente eseguita attraverso l'opzione Interpolate nel menu  
Edit → Edit Topography. Successivamente è possibile cancellare il punto 
che prima identificava la brusca variazione di pendenza. Grazie a questa 
operazione viene livellata questa brusca variazione ed aumentata la 
stabilità numerica. La figura 9 illustra un simile livellamento.  
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Figura 9: livellamento di una brusca variazione di pendenza per limitare le instabilità numeriche.      

 
 
Problema: le instabilità numeriche si verificano con valanghe dense nella parte superiore 
del percorso 

 
 

Una tipica instabilità numerica nella parte superiore del percorso della 
valanga è illustrata nella figura 10. Si verifica prevalentemente nei punti 
pianeggianti del percorso. Particolarmente critici risultano i punti di 
passaggio tra tratti di percorso forma concava e tratti di forma convessa. 
L'instabilità si verifica quando la valanga si è già arrestata a fondo valle. Il 
motivo di tali instabilità è dovuto al fatto che nella parte superiore del 
percorso la valanga continua a scorrere con altezze di deflusso molto 
basse. Valori così bassi facilitano l'insorgere di instabilità numeriche.  

 
Figura 10: caratteristiche tipiche di un'instabilità in prossimità del fronte della valanga. L'instabilità 

è indotta dal repentino passaggio dal terreno pianeggiante alla contropendenza. A causa 
dell'instabilità numerica vengono generate velocità anche maggiori di  800m/s.  
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Rimedio: riduzione del limite temporale Max Time  

In una prima fase occorre controllare se il fronte della valanga si è già 
arrestato. In caso affermativo, localizzare il momento approssimativo in cui 
il fronte della valanga si è arrestato. Successivamente confrontare questo 
momento con l'istante in cui si è verificata l'instabilità. Di norma, dovrebbe 
esserci una notevole differenza di tempo tra i due momenti (>20s). Per 
risolvere il problema, impostare il limite temporale Max Time al valore 
medio risultante da questi due istanti. 
 

 
 
Problema: scostamento notevole tra l'estremità del deposito e l'estremità della zona blu.  

 
 

Solitamente questo problema si verifica in presenza di percorsi molto 
lunghi e stretti. La figura 11 illustra il tipico caso di una simile discrepanza. 
Il motivo di questa enorme differenza tra la distribuzione dei depositi e il 
limite della zona blu è dovuto al fatto che la funzione di interruzione 
automatica low Mass Flux Condition non funziona con questo tipo di 
topografia. In un percorso molto lungo e stretto, più dello 0.04% della 
massa complessiva rimane in movimento. A causa della pendenza del 
percorso, questa massa non può essere depositata sul pendio ma giunge 
sino a valle, dove nella circoscritta area di deposito si accumula 
notevolmente in altezza.  

 
Figura 11: rappresentazione della distribuzione del deposito e dell'andamento delle massime forze 
di pressione. Una grossa discrepanza è rilevabile in prossimità del limite tra la zona di pressione blu-

bianca e l'estremità del deposito.  

La simulazione numerica tende tuttavia a diminuire la concentrazione di 
massa distribuendola su un'area più vasta . Di conseguenza, il deposito che 
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all'inizio si accumula notevolmente in altezza, si ridistribuisce a velocità 
molto basse (<0.01m/s, figura 12). E' un fenomeno numerico che di norma 
può essere evitato con la funzione di interruzione low Mass Flux 
Condition.  

 
Figura 12: rappresentazione delle velocità di diffusione estremamente basse nell'area di deposito. 

Le velocità massime al centro dell’area di deposito sono pari a 0.01m/s.  
   
   

Rimedio: riduzione del limite temporale Max Time  

In un caso simile non è determinante la distribuzione del deposito nel momento 
dell'interruzione della simulazione, ma la sua distribuzione nel momento in cui viene 
raggiunto il limite della zona blu-bianca. La soluzione del problema si ottiene 
interrompendo il calcolo nel momento in cui il fronte della valanga raggiunge il limite di 
passaggio tra la zona blu e la zona bianca. A tale proposito è necessario impostare il 
limite temporale Max Time al relativo valore. 
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7.4 FAQ – Valanghe polverose 
 
Problema: nella finestra inferiore, le altezze massime del manto nevoso sembrano 
esplodere. 
Problema: la simulazione della valanga polverosa si conclude apparentemente senza 
problemi, tuttavia nei risultati non si vede alcuna valanga!?! 
Problema:  lo strato di saltazione genera un'immensa gobba e subito dopo SL-1D 
interrompe prematuramente il calcolo.  
Problema: in prossimità di un cambio repentino di pendenza o del versante opposto, la 
valanga polverosa sembra impazzire: le altezze di flusso formano dei picchi e la valanga 
sembra sbriciolarsi. 
Problema: la velocità del fronte e la pressione di ristagno sul versante opposto sembrano 
diminuire con una lentezza irreale.  

 
Problema: nella finestra inferiore, le altezze massime del manto nevoso sembrano 
esplodere. 
 
 

Durante l'osservazione delle altezze massime del manto nevoso nella 
finestra inferiore risulta la seguente immagine (vedere figura 13):  

 
Figura 13: le oscillazioni dell’altezza della neve nella finestra inferiore e i picchi nella parte 

superiore dello strato polveroso sono indizi evidenti di un'instabilità numerica.  

Rimedio: questo problema è da ricondursi ad un'instabilità numerica, il cui 
principale indizio è rappresentato dai picchi presenti nella parte superiore 
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dello strato polveroso della valanga. Controllare a partire da quale time step 
compaiono per la prima volta questi picchi e ridurre il tempo massimo di 
calcolo al valore in cui è iniziata l'instabilità, diminuito di un secondo 
(ovvero ripetere la simulazione!).    

 

 
Problema: : la simulazione della valanga polverosa si conclude apparentemente senza 
problemi, tuttavia nei risultati non si vede alcuna valanga!?!  
 

Questo fenomeno si verifica soprattutto in presenza di masse iniziali molto 
piccole, se il valore di soglia Cell Cut-Off (cfr. punto 3.4.2, pag. 50) non 
viene ridotto al di sotto del valore di default di 10.0. Dopo il primo time 
step, sia il flusso di massa che la quantità di moto all'interno dei due strati 
della valanga polverosa scendono al di sotto della soglia Cell Cut-Off e 
tutte le celle della griglia vengono disattivate. Ovviamente, non essendoci 
massa la valanga non può essere simulata.  

Rimedio: in Edit → Calculation Parameters... → Powder Snow 
impostare l'opzione Cell Cut-Off su un valore inferiore a 10.0 (p.es. 5.0). 
Se il problema persiste anche con un valore di 5.0, significa che è stata 
impostata una massa iniziale inaccettabilmente bassa, oppure che è 
subentrato un altro problema che deve eventualmente essere controllato 
con il Centro di Assistenza presso l'Istituto SNV (salvare il file di input!).  

 

 
Problema:  lo strato di saltazione genera un'immensa gobba e subito dopo SL-1D 
interrompe prematuramente il calcolo.  
  
 

Se viene impostata una soglia di erosione del manto nevoso troppo  bassa, 
tutto il manto nevoso verrà immediatamente eroso all'inizio della 
simulazione, all'interno delle prime celle di calcolo. La massa viene trasferita 
direttamente nello strato di saltazione, concentrata in poche celle. Dato che 
la densità massima dello strato è fissata a 100kg/m3, la massa si espande 
in altezza dando origine alla gobba osservata durante la simulazione.   

Rimedio: in Edit → Avalanche Parameters... → Powder Snow 
impostare l'opzione Erodibility con il corretto valore (cfr. punto 3.4.1, pag. 
46). Informazioni sulla scelta realistica di tale parametro sono incluse nel 
manuale di istruzioni. 

 
 
Problema: in prossimità di un cambio repentino di pendenza o del versante opposto, la 
valanga polverosa sembra impazzire: le altezze di flusso formano dei picchi e la valanga 
sembra sbriciolarsi. 
  
 

Il fronte della valanga, più alto e più compatto, esercita una pressione 
idrostatica frenante sulla coda della valanga. Specialmente in 
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corrispondenza ad aree pianeggianti o a contropendenze, la coda della 
valanga viene notevolmente rallentata. Nei casi estremi tale situazione 
causa un'inversione della direzione di movimento in alcune celle e instabilità 
numeriche.  

Rimedio: se tale effetto si verifica nella zona di scorrimento della valanga, 
in corrispondenza a piccoli tratti piani o a temporanee controtendenze, una 
piccola variazione delle topografia del terreno rappresenta la soluzione più 
semplice ed efficace. A tale proposito, attraverso l'opzione Edit → Edit 
Topography (in modalità input) correggere leggermente le altezze dei 
punti attigui al fine di livellare la brusca variazione di pendenza.  

Generalmente, quando subentra l'instabilità, la valanga ha già raggiunto il 
fondo valle e in questo caso i parametri dinamici della simulazione sono già 
stati  calcolati (ciò  può essere facilmente controllato, per esempio, con 
Time Plot Pressure). La cosa migliore da fare è quella di ripetere il calcolo 
riducendo il tempo della simulazione al tempo in cui si produce l'instabilità, 
diminuito di un secondo. Se l'instabilità subentra in prossimità della coda 
della valanga, aumentare il valore della soglia  Cell Cut-Off in Edit → 
Calculation Parameters... → Powder Snow del 30-100%.  

 
 
Problema: la velocità del fronte e la pressione di ristagno sul versante opposto sembrano 
diminuire con una lentezza irreale.  

 

La versione 0.5.8 di SL-1D ignora la resistenza aerodinamica del fronte 
della valanga. A causa della pressione idrostatica esercitata dal corpo della 
valanga, il fronte viene accelerato eccessivamente e si assottiglia. Di 
conseguenza, i valori massimi di pressione si verificano in posizione troppo 
arretrata rispetto al fronte. Un ulteriore motivo è rappresentato dal fatto 
che AVAL-1D non permette alla valanga di svilupparsi lateralmente.  

Rimedio: sino alla pubblicazione di una versione più aggiornata, i valori di 
pressione ottenuti devono essere attentamente valutati e progressivamente 
ridotti in modo direttamente proporzionale alla distanza dal punto di 
distacco. A seconda delle caratteristiche di estensione laterale della valanga 
reale, occorre scegliere un fattore di riduzione compreso fra 0.3 e 1. Per un 
controllo, è possibile ricorrere alla formula per la valutazione delle altezze di 
ascesa incluse nel manuale di istruzioni Considerazione delle valanghe 
polverose nella rappresentazione cartografica dei pericoli.  
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